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Marianas LightSheet Window
The Marianas LightSheet Window is used to align your MLS system prior to experiments, set up all SPIM capture parameters
ad initiate SPIM image capture. You may use these controls to change settings of microscope, stage and SPIM devices in order
to find and position your specimen, mark the z range for capture, calibrate scanner to piezo movement, set up FRAP parameters
and initiate capture.

To open the Marianas LightSheet controls within SlideBook, go to the Home tab, Acquire group >  LightSheet >
Marianas LightSheet.
 
See also:

Marianas LightSheet Hardware
Marianas LightSheet Alignment and Calibration
Marianas LightSheet Operation
 

XY Stage group

 
•  Arrows Move the XY stage stepwise in X or Y
•  Increment of steps (μm) can be selected by typing values or select in the drop down
•  When running in live mode the current X and Y positions are updated

SPIM Z Drive group

 
•  Arrows Lower (arrow down) and withdraw (arrow up) the SPIM drive towards or from the sample for 10 μm, 1 μm,
0.1 μm or a given value (e.g. 1000-50000 μm) respectively



  

  

•  Load brings the SPIM Z drive to its most upper position to enable sample loading. This button will change to Return
when a sample height was engaged before
•  Return will bring the SPIM Z drive to its previously visited lower position at the coverslip
•  Go brings the SPIM Z drive to the value specified in the field left to the button -  NOTE: the value is in μm
 

Imaging Piezo A group

 
•  Z indicates the current piezo A position
•  Arrows Retract (arrow down) and expand (arrow up) piezo A for 10 μm, 1 μm, 0.1 μm or a given value (e.g. 70 μm)
respectively
•  Center brings the piezo to zero position (0 μm) - NOTE: holding the piezo at zero position is active, piezos will go to
sleep/ relax after 5min without activity latest

Imaging Piezo B group

 
•  Z indicates the current piezo B position
•  Arrows Retract (arrow down) and expand (arrow up) piezo B for 10 μm, 1 μm, 0.1 μm or a given value (e.g. 70 μm)
respectively
•  Center brings the piezo to zero position (0 μm) - NOTE: holding the piezo at zero position is active, piezos will relax
after 5min without activity

Controller Inputs group

 
•  Joystick controls the XY movement of the stage (no alternative selection available)
•  Select which device (scanners, piezos, SPIM Z Drive) is controlled by the Left wheel of the Joystick controller box
•  Select which device (scanners, piezos, SPIM Z Drive) is controlled by the Left wheel of the Joystick controller box
•  Update All will update the selection (not required when in live mode)
•  Limits... will open an additional interface allowing to change further settings, such as Stage limits, Grid spacing,
Window size, Scan Frequency & other Scan settings as well as it contains a command line to communicate to the ASI
Tiger Controller

Lower Z Stage group



  

  

 
•  Z indicates the current position of the lower / sub-stage objective, microscope nose piece
•  Arrows Lower (arrow down) and raise (arrow up) the lower objective for 10 μm, 1 μm, 0.1 μm or a given value (e.g.
5 μm) respectively

Path control group

 
•  Path A: tick-boxes to enable Beam or Sheet (dithered beam) for scanner of side A
•  Path B: tick-boxes to enable Beam or Sheet (dithered beam) for scanner of side B
•  Laser Switch: Select which device (scanners, piezos, SPIM Z Drive) is controlled by the Left wheel of the Joystick
controller box
•  Select which device (scanners, piezos, SPIM Z Drive) is controlled by the Left wheel of the Joystick controller box
•  Update All will update the selection (not required when in live mode)

Sheet control group

 
•  Adjust the Sheet axis or Slice position by sliders and arrows. NOTE: Changing the slice position by using the joy
stick wheel is recommended for easier use.
•  Center will bring each sheet axis or slice position to centre individually.
•  Neutral All brings the scanner position in all directions as well as the piezos to their center position (initial
alignment point for most range).
•  HALT instantly stops all SPIM Z drive movement, stage movement, scanner and piezo movement.
•  When scanners with motorized irises are installed one can control the Aperture for each scanner (T for scanner A, U
for scanner B) either by typing a specific value and click Go or selecting a percentage (how far open) in the drop down
menu.

Imaging setup group



  

  

 
•  Indicates coordinates and selection (Go to, Set center) of the Imaging center
•  Indicates selected Path
•  Calibration Status: indicates whether a calibration is saved for the path and shows the calibration curve
•  Indicates selected Objective - NOTE: Requires manual change after changing objectives
•  Indicates the Slice position for the respective Piezo position at Calibration start and Calibration end
•  Arrows (top of the group) move both piezo and slice position stepwise according to the calibration curve, the piezo
step distance (um) can be altered by typing a value
•  Adjust (calibration check) positions the slice Position of the scanner of the selected path (drop down) to the selected
piezo position of this path according to the calibration curve (e.g. after clicking Neutral All, Adjust brings the slice
position from zero to it's calibrated position for piezo center position)
•  Sheet width adjusts the width of the sheet over the field of view (slider or arrows) - NOTE: hold Ctrl while clicking
the arrows will move it with 10x increment
•  Sheet offset adjusts how centered the sheet is scanned over the field of view (slider or arrows) -  NOTE: hold Ctrl
while clicking the arrows will move it with 10x increment

Photostimulation group

 
•  Select parameters (Exposure time in ms, Binning, Channel) for imaging with the finder Camera
•  Toggle Shutter opens or closes the selected Epi-port excitation
•  Live/ Stop enables and disables the Live mode of the camera (separate view window)
•  X & Y indicate the set stage coordinates for the photomanipulation
•  Center will move the stage to the center between the start and end coordinates of a stage scan
•  Go moves the stage to the set photomanipulation coordinates
•  Set will set the photomanipulation coordinates to the current stage possition
•  Edit Sequence... select and set photomanipulation channel and parameters before capture

Scan Configuration group



  

  

 
•  Select the SPIM capture mode - Piezo/ slice scan or Stage scan - in the drop down
•  Sides select how many views are going to captured ('1' for a single view SPIM capture, '2' for a dual view SPIM
capture)
•  First side allows to choose between sides for a single view SPIM capture
•  Number of planes type the required number of Z-planes for each stack for Piezo/slice scans, for Stage scans it will
indicate the number of planes as calculated from Step size and Scan distance
•  Step size enter a value for the inter-plane spacing (real Z, not stage step for stage scan)
•  Left stage coordinates for stage scan start, Go will move the stage to the saved position, Set will set the stage scan
start coordinates to the current stage position
•  Right stage coordinates for stage scan end, Go will move the stage to the saved position, Set will set the stage scan
end coordinates to the current stage position
•  Go Center will move the stage to the center between the start and end coordinates of a stage scan
•  ? will present calculated scan parameters as the Total scan distance, Stage velocity, Scan duration, Slice (frame)
timing and number of Total Images (computed)
•  Advanced... will open the MLS Advanced Acquisition Parameters interface allowing to enable further channels, set
their parameters and choose from different scan options

Capture group

 
•  For timelapse captures enter the number of Time points and the desired Interval, select the interval unit (e.g. ms)
from options in the drop down
•  Channel A: drop down to select the laser line for side A, Go enables the laser
•  Channel B: drop down to select the laser line for side B, Go enables the laser
•  Drop down selection of Laser power (in %)
•  Option to Enable A/B power balancing to achieve similar intensities for each side
•  Balance (B%) enter a value (% of power side A) to regulate the laser powers of each side separately when power
balancing is enabled
•  Indicates which chip size, binning and how many channels are currently activated
•  99% tick box to restrict the camera intensity range to the 99% of the brightest signal
•  Close Alt/ Open Alt enable and disable lasers
•  Live enables live mode of cameras and opens a separate viewer
•  Tick boxes for operation:



  

  

•  Dual cam enables switching between side A and B for simultaneous view in live mode
•  Histo shows the minimum and maximum intensities for each side in the camera live view window
•  CY enables the cyan and yellow look up
•  Grid plots a grid over the live view window to assist alignment

•  Select a chip size
•  64 - 64 x 64 pixel (px)
•  128 - 128 x 128 px
•  256 - 256 x 256 px
•  512 - 512 x 512 px
•  1k - 1024 x 1024 px
•  Full Chip - 2048 x 2048 px

•  Factor crops image size in Y only, select options in drop down
•  Bin enables binning, select options from drop down



  

  

Marianas LightSheet Module
The Marianas LightSheet (MLS) represents our turnkey system to exploit the Dual-view Inverted Selective Plane Illumination
Microscopy (diSPIM), a pencil beam light sheet method offering low phototoxicity in 3D imaging making it possible to image
living cells and small organisms over extended periods of time. It is a flexible light-sheet system with an open specimen
geometry not requiring special slides or capillaries. This Selective Plane Illumination Microscope images a specimen using
two perpendicular light sheets from two equivalent optical paths and objectives which are each used sequentially for both
illumination and imaging. The resulting 3D datasets have isotropic resolution in X, Y and Z with only two views, resulting in fast
image capture with low light dose for extended specimen viability.
    
Two matching water dipping objectives can have an NA of up to 0.8 with a working distance allowing efficient orthogonal
mounting. Each objective is used for excitation and emission collection via identical high-speed high-resolution sCMOS cameras.
A third objective is located below the specimen chamber for locating the sample. Photomanipulation, such as the Ablate!
photoablation system, can be added via the microscope's side- port.
 
 

 
 
 
 
 



  

  

System Hardware
The system consists of two symmetric optical paths (unless in the case of Single View SPIM systems) for light sheet imaging.
Two objectives are placed at right angles above a sample mounted horizontally. A light sheet is created from one objective and
then imaged using the other objective. A stack of images is collected by moving the light sheet through the sample. The role of
each two objective can be exchanged to collect another stack from a perpendicular direction, and then the two datasets can be
computationally merged to yield a 3D dataset with isotropic resolution. The diSPIM assembly is mounted on a linear stage, SPIM
Z Drive, which raises and lowers the objectives from the sample chamber.

 
 
 

(1) Scanner; (2) Dichroic Mirror; (3) Imaging Objective; (4) Piezo; (5) Camera (Upper) Mirror; (6) Camera
Blue depicts Path A components Green depicts Path B components

 
The MLS system comes as the dual light path module mounted on any inverted Zeiss, Nikon, Olympus, or Leica microscope
frame. For each imaging channel, two filters will need to be configured, one for Path A and one for Path B as depicted below. It
is also important to note that both objectives are used in each path, one for illumination and one for imaging and this switches
depending on the path.
 

 
The MLS can be controlled in software or by the accompanying joystick. Review the following diagram to become familiar with
the joystick functions. The left wheel (1) controls the SPIM Z Drive. The right wheel (2) controls the Piezo or Slice Position and is
set in software. The button on the joystick (3) toggles the XY stage movement between fast and slow.
 



  

  

 
 
 
 



  

  

MLS Alignment and Calibration
 
MLS system alignment is an integral part of system use. Alignment and calibration should be checked and refined any time you
change sample type/thickness, sample buffer, room temperature, or any other factor that could impact optical properties of the
setup. Optimal image quality can only be achieved when alignment and calibration are complete.
 
This section of our help contains several tutorials. No tutorial is a standalone document; the "steps" may need to be repeated
several times in an alternating fashion until alignment is complete. It is recommended to first attain a close approximation for
each alignment, proceed with the rest of the alignment steps, and then come back to each step to finish. It is easiest to perform
the fine alignment in a dye solution like fluorescein (beam alignment requires a high signal to noise ratio). The final steps can
also be performed with a 2D sample of fluorescent beads.

 
Broadly speaking, the tutorials cover bringing the specimen into focus, focusing the objective bushings, eliminating focus and
rotational tilt, and calibrating the piezo/slice relationship.
 

Equipment needed for alignment and calibration:
•  dye solution (ex. Fluorescein) and/or a dense solution of beads/ fluorescent particles
•  Allen wrench (3/32" size) - applies to systems installed before November 2017 only

 
 
 
 



  

  

TUTORIAL: Using the SPIM Drive to Introduce Objectives into the Sample Chamber
 
Lowering the objectives into the sample chamber is a delicate task; it is essential that the sample chamber is centered below the
objectives.
 

1. 
 
Open the Marianas LightSheet controls within SlideBook, go to the Home tab, Acquire group >  LightSheet >

Marianas LightSheet.
 
2.  When using the system for SPIM, you will need to raise and lower the objectives using the SPIM Z Drive in SlideBook. To
do so, enter a value such as 1000 or 100 when closer to the coverslip) in the custom Z step size field and use the up and down
arrows to control the drive. The large STOP button in the lower left of the dialog can be used as an emergency brake for the
SPIM Z Drive at any time; the HALT button on the joystick also works as an emergency brake.
 

 
3.  You will need to raise the objectives using SPIM Z Drive to load a sample. Use the Load button to withdraw the objectives
completely.

NOTE: The Load button will become the Return button when the drive has reached its maximum height.
 

 
4.  Once the sample is in place, you will want to move the SPIM Z Drive so the front lens of the objectives are fully submerged,
this configuration will typically put you in position just above the coverslip.
 

NOTE: If you use the Return button, the drive will lower to the previous sample position. Make sure your coverslip or
sample is not higher.

 
5.  Incrementally step down SPIM Z Drive by entering a value into the SPIM Z Drive group as described in step #2.

NOTE: Turning on the Upper LED in Path control may add helpful additional illumination
 

 



  

  

6.  In the Path Control group, select a Beam for both paths. In the Capture group, select a filter for Channel A and Channel B
respectively. Click Go for either of the channels then Live to activate lasers.
 

 
6. The next tutorials will cover co-focusing and aligning the objectives. For imaging samples, you will want both laser paths to be
present in the middle of the field of view through the oculars. For alignment, you will want both laser paths to be present on the
edges of the field of view through the oculars as shown below.
 

 
 
 
 
 



  

  

TUTORIAL: Co-focusing the SPIM Objectives
 

1. 
 
Open the Marianas LightSheet controls within SlideBook (Home tab, Acquire group >  LightSheet > Marianas

LightSheet).
 
2.  Refer to TUTORIAL: Using the SPIM Drive to Introduce SPIM Objectives into the Sample Chamber.
 
3.  To prepare for co-focusing the SPIM objectives, perform the following steps:

a.  In Path control, select Beam for both paths.
b.  In Sheet control, click Neutral All to return the slice position to its neutral position.
c.  In Capture, select the same filter configuration for Channel A and Channel B. Be sure to use opposite path
designations. Click Go for each.
d.  Check the box to Dual Cam to see both beams.
e.  Click Live to start a live stream from the cameras.
f. (Optional) When in dual camera mode, red represents Path A and green represents Path B. You can check the box CY
  to view Path A in yellow and Path B in cyan.
 

 
4.  Use the iris on the back of each scanner to adjust each beam to a pencil beam. The iris fully closed when the small lever is to
the right as seen from the front of the microscope (pictured from the back of the microscope below).
5.  When your system is equipped with motorized irises, got to the Sheet control group, type a small value (can be -70000) and
click Go or set 0% using the drop down menu for each iris Aperature T and U to achieve a pencil beam.

 
Manual Iris



  

  

Motorized Iris
 

 
 

 
6.  Select Channel A > Go, adjust the imaging objective's focus on the beam using the corresponding Objective Threaded
Bushing (A) to focus pencil beam. Select Channel B > Go, adjust the beam’s focus using the corresponding Objective
Threaded Bushing (B) to focus pencil beam. Alternate between adjusting the two Objective Threaded Bushings; you will need
to click Go for the corresponding channel each time). Either move half way to the focus at a time before alternating sides to
achieve convergence (even if there is a bit of play in the Objective Threaded Bushings) or adjust while in the Dual Cam mode.

 
NOTE: If you have the feeling one objective is much further out than the other, turn both in by rotating the bushings
clockwise and start the focusing anew, making sure you turn both bushings out about the same way each time.

 



  

  

 
7.  If the pencil beam is effectively focused, you will see an interference pattern present around the beam and can proceed to
TUTORIAL: Co-aligning the Beams.

 

 
8.  After the pencil beams for both channels are focused, you may notice some tilt (either rotational or focus). Please see
TUTORIAL: Adjusting the Tilt of the Pencil Beam to correct for horizontal rotation (YZ tilt) or focus inconsistency (XY tilt).
 

 
 
 
 
 
 



  

  

TUTORIAL: Adjusting the Tilt of the Pencil Beam
 
YZ Tilt (rotational)
The YZ Tilt is apparent when viewing the beam through the camera; if the YZ tilt needs to be adjusted the beam is slightly
rotated in the YZ dimension.
 

 
To correct the YZ Tilt, adjust the dichroic mirror using both screws B and C on the filter cube of the desired path.
 

 
1.  Turn on gridlines in the live view by checking the Grid box, click Go for Channel A to activate Path A.
 



  

  

 
2.  Adjust both Screw B and Screw C of the Path A dichroic mirror until the beam is horizontal and parallel to the grid lines.
 
3.  Repeat for Path B (by clicking Go for Channel B and adjusting both Screw B and Screw C of the Path B filter cube) until
both beams are in focus and parallel with the horizontal gridlines across the field of view. Do not be concerned if beams are not
in center of field of view (the beam just needs to be uniform at this point).
 

 
 
XY Tilt (focus)
The XY Tilt is apparent when viewing the beam through the camera; if the XY tilt needs to be adjusted, the beam will appear as
if it is coming toward (and away from) the camera.
 



  

  

 
To correct XY Tilt for Channel A, you will adjust the dichroic mirror using  Screw A only of the Path A filter cube. To correct XY
Tilt for Channel B, you will adjust the dichroic mirror using Screw A only of the Path B filter cube.
 

 
1.  Make sure sheets and slices are centered by clicking Neutral All and Center for all sheet and slice positions.
 

 
2.  In the Controller Input group of Marianas LightSheet controls, set Right wheel to Piezo A for Path A using the drop-down
selection. Confirm that Channel A and Channel B (in the Capture group) are set to the same filter for their respective paths. Click
Go for Channel A to activate Path A.
 



  

  

 
3.  Defocus the beam using right wheel on the joystick.
 

 
4.  Adjust Screw A of Path A only or Screws B & C together on the filter cube manually with an Allen wrench until beam is
uniform across the field of view.
 



  

  

 
5.  Select Neutral All to restore the slice position to its neutral position.
 
6.  Refocus both pencil beams using the objective threaded bushings (as described in TUTORIAL: Co-focusing the SPIM
Objectives) until pencil beam is uniform across the field of view.
 
7.  Repeat steps 1-5 for Path B (setting Right wheel to Piezo B, clicking Go for Channel B, and using Screw A only of Path B
filter cube) until both beams are in focus across the field of view. Do not be concerned if beams are not in center of field of view
(the beam just needs to be uniform at this point).
 
 
 

 



  

  

TUTORIAL: Co-aligning the Beams
 
Prepare a sample for the MLS alignment, use the imaging media you will be imaging your samples in (water or PBS are
acceptable but not ideal). To better visualize the beams, add a small amount of fluorescein or phenol red. For this tutorial, you
will need to show beams and spots from both paths. To do so, check 3 boxes in the Marianas LightSheet dialog:
 

•  Dual Cam
•  Laser Switch
•  Grid

 

 
Throughout the tutorial, you will be adjusting the Camera (Upper) Mirror for each path. You will be using an Allen wrench in
Screw A (left-right), B, and C (diagonally up-down) of Path A and Path B as depicted below.
 

•  Use Screw A on the Camera (Upper) Mirrors to move the beam and spot left and right for each path.
•  Use Screws B and Screw C on the Camera (Upper) Mirrors to move the beam and spot vertically with a slight
horizontal bias for each path

 

 
In the live window, Camera 1 (Path A) will be pseudocolored red while Camera 2 (Path B) will be pseudocolored green.

NOTE: For our color blind users, activate CY checkbox (under the Grid checkbox) to view beams and spots as Cyan
(Path A) and Yellow (Path B)

 



  

  

 
1.  Use a combination of screws A, or B and C to move both the green and red spots to the center of the grid. Do not worry about
the vertical location of the beams at this point.

NOTE: The image below shows the CY pseudocoloring for color blind users.
 

 
2.  Use the Lateral Adjustment Knob (located on the front of Piezo B) to overlay all beams and spots at the center of the grid.
 



  

  

 

 
3.  Unselect Dual Cam and Laser Switch. The pencil beams for both path A and B should be uniform and centered.
 
4.  To test uniformity, you can use the Right wheel to adjust the slice position to see the beams go out of focus uniformly. To do
so, click Go for Channel A, this should set Slice A to the Right wheel. Rotate the wheel and check the beam goes out of focus
evenly in both directions. Click Neutral All to bring the slice position back to center. Repeat the same for beam B by setting
Slice B to the Right wheel by clicking Go for Channel B.
 



  

  

 
 
 
 
 



  

  

TUTORIAL: Calibrating the Piezo and Slice Position
 

Before you begin this final step of alignment and calibration, it is essential that pencil beams for both Path A and Path B are both
uniform and centered as described in the earlier tutorials. To get ready for this tutorial, you will need to click Neutral All, and
have the appropriate filter selected for Channel A and Channel B.
 

NOTE: It is recommended to use the imaging media  you will use for your sample for this calibration or, at the very
least, a solution with the same refractive index.

 

 
1.  Check the box for Beam for Path A and Path B.
 

 
2.  For Channel A, click Go. In the Imaging Piezo A control, enter 70 and click the down arrow to drop Piezo A down 70µm (for
a 150µm travel piezo), the beam will go out of focus.

NOTE: A Z value is displayed above the arrows, this will indicate the current position of the piezo. For a 150 µm Piezo
it will range between -75 to 75 max. Always make sure the opposite piezo is at center position when starting the
calibration.

 



  

  

 
3.  Adjust the right wheel on the joystick (confirm Controller Inputs, Right wheel = Slice A) until the beam is in focus and
uniform.
 

 
4.  In Imaging Setup, click Set to select the Calibration start for the piezo.
 



  

  

 
5.  In the Imaging Piezo A control, click Center to bring the piezo back to 0.0um then click the up arrow to raise it 70um.
 

 
6.  Adjust the right wheel on the joystick until the beam is in focus and uniform.
 
7.  In Imaging Setup, click Set to select the Calibration end for the piezo.
 

 
8.  Return Piezo A to center by selecting Center (as in Step #4) and select Adjust (the beam should become focused again) to
check the calibration.
 
Repeat steps #1-#8 for Path B and Piezo B.
 
 
 
 
 



  

  

TUTORIAL: Setting Sheet Width and Offset
 
Once the Beams are aligned and calibrated return to the neutral position and continue to set the sheet width and offset.
 
1.  In Path Control, check the boxes for Beam and Sheet for Path A and Path B. Click Neutral All. 
 

 
2.  Check the box to turn on the Grid for easier alignment. Adjust the Sheet width (displayed as the vertical height of the
sheet) to just outside the field of view. In the following example, the field of view is the center four squares of the grid. If the
sheet is not perfectly centered, adjust the Sheet offset using the slider or arrows. Once the sheet width is correct and centered
in the field of view, click Set Both to apply the width to the other sheet.
 

NOTE: The arrows to the right of the sliders can be used to adjust sheet width and offset. The step size for a single
arrow button click is 0.001 units. Hold CTRL while clicking the arrows to use a step size of 0.01 units.
 



  

  

 
3.  Check the box for Dual Cam mode to check the sheets are overlaid. When you are in Dual Cam mode, the sheet width
and offset will only adjust for the active channel, the channel you for which you last clicked Go. Use the Go buttons to toggle
between Channel A and Channel B while adjusting the offset until the sheets are well aligned as shown below.
 

 
4.  At this point, you should find a good Z location for loading and unloading samples. Using the SPIM Z Drive group arrows,
slowly lower the Z drive until the sheets start to hit the coverslip as shown in the following image.



  

  

 

 
5.  Move back up 200-300 µm and write down/remember the Z position. You can later return to this position by typing the value
in the text field and clicking Go once your sample is loaded.
 

 
 
 
 
 



  

  

TUTORIAL: Alignment for Equalizing Beam Power
 

Normalizing laser power between Path A and Path B will yield the best reconstruction and analysis results. This power balancing
has a hardware component and a software component. Read below for instructions on the hardware component.
 
1.  Align the beams (in pencil beam mode) according to MLS alignment protocol: MLS Alignment and Calibration (all steps).
 
2.  Adjust the scanner irises in beam mode so that the beams/ beam waists have the desired thickness.
 

3.  In the MLS window check Dual Cam and Histo to see both channels and their maximum and minimum intensities the same
time. Bring the beams slightly apart using the Lateral Adjustment Knob as shown in the following image.

 

 
4.  Carefully adjust the irises so that each beam shows a similar shape as well as a similar intensity is reported in the lower right
of the live window.
 



  

  

     
 

NOTE: It is best to refine this in sheet mode and using your sample, if necessary you can also use Software Integrated
Power Balancing.

 
5.  Bring the beams back to overlap in the center and continue with the usual set-up of the experiment.
 



  

  

MLS Operation
Once the beams are aligned, a sensible sheet width is set, and piezo and slice distances are calibrated, you can start imaging
your samples. This section of help pages will walk you through MLS operation from locating your sample to refining the
calibrations through to image acquisition.
 
 
 
 
 



  

  

Locating and Positioning the Sample
Locating the Sample
 
1.  Use the Load button to fully withdraw the SPIM Z Drive.
 
2.  Load the sample, it should be prepared and placed on a 24 x 50 mm slide in its chamber (ideally within a centrally located
circle of ~5mm diameter) or 10 mL petri dish .
 
3.  Click on the binocular icon to direct light to the oculars and the Toggle FL button to turn the fluorescence on and off.
Observe with one of the lower objectives. Focus with the microscope drive and position an object of interest by carefully moving
the xy stage using the joystick.
 

NOTE: The button on top of the joystick handle changes the XY travels speed from fast to slow. Be sure to use the slow
drive when the upper objectives are immersed to prevent objective crashing and damage, especially when using the
stainless steel imaging chamber.

 

 
4.  Once the sample of interest is located in the center of the field of view through the oculars check the boxes to select Beam
and Sheet for both paths and click Go and Live. You might want to use Dual Cam mode while driving the Z Drive down to the
sample using the Return button.
 

 
Approaching the Sample
 
1.  Check the boxes for Beam and/or Sheet and turn down Laser Power to about 5%.
 
2.   Select a filter for Channel A and Channel B and click Go for one path.
 
3.  Lower objective without crushing the sample, as outlined in TUTORIAL: Using the SPIM Drive to Introduce Objectives into the
Sample Chamber.
 

IMPORTANT INFORMATION TO NOTE:
 

•  The beams are quite powerful when set to 100%, they will photobleach your sample (adjust sheet/beam power as
necessary for your sample).
 
•  Move the Z/SPIM drive to a "safe" position (this is a position we determined at the end of TUTORIAL: Setting Sheet
Width and Offset). From this safe position, move in small increments toward your sample, being careful not to crush it.
 
•  Select both Path A and Path B Sheets, and activate Dual Cam function as the objectives are lowered to visualize
the co-focus point in relation to the sample and visualize Path A and Path B on the screen.
 



  

  

•  Once the sample enters the field of view of the cameras, continue to move the SPIM drive towards the sample using
the Left wheel of the joystick until Path A and Path B are overlapping in the center.
 
•  Once the sheets are overlapping (both hitting the sample at the center), move slightly left and right and up and down
with the joystick to bring the sample of interest in the center and similarly hit by the sheets.

 

 
•  To image smaller objects, consider cropping the camera field of view to an appropriate size by clicking 1k (through
to 64 x 64 pixels) or narrow the field of view using the Factor drop down. This will save considerable space in data
capture. And there is also an option (drop down Bin) for binning if you are OK sacrificing resolution for signal.
 
•  Also consider adjusting the piezo range to your field of view or vise versa before capture.
 
•  When imaging a small volume (e.g. cells on a coverslip), it is recommended to open the scanner iris slightly in order
to narrow the beam waist. Best, adjust the beam width while in Dual Cam mode in solution (Z drive is slightly above
samples).

 
 
 
 
 
 



  

  

Before Capture
Before you can set up an experiment to capture, do the following:
 
1.  Save the .sld file.
 
2.  Ensure sheets are completely overlapped and your sample of interest centered to maximize the acquisition area for alignment
and post-image processing.
 
3.  Select the correct objective.
 

 
4.  Consider the objective and camera crop you are using  for choosing the appropriate number of planes and step size
(Hamamatsu 6.5 µm/px with 40X gives you 160 µm with 1k = use full range of piezos, 83 µm with 512x512 = use about 80 µm
of the piezo range).
 
5.  Consider the camera crop and adjust the sheet width accordingly (just slightly over the field of view).
 
6.  Test calibration in sheet mode by moving Z in the Imaging Setup group. The sample should stay in focus when the Z
coordinate is changed.
 

 
7.  Make sure that slice position is adjusted for piezo positions using the previously determined calibrations. To display the
calibrated values, select Adjust in MLS Imaging Setup window. Repeat for Path B.
 

NOTE: If refining the calibration is necessary, see Refine an Existing Calibration.
 
8.  Check that the Imaging center is set to 0.0 #m for both sides.
 
 
 
 
 



  

  

Refine an Existing Calibration
 
If an existing calibration has been set and the pencil beams are uniform and centered, you can fine tune the calibration using
following instructions.
 
1.  Click Go for Channel A. In Imaging setup, select Path A and click Go to for Slice, Calibration start.  
 

 
2.  Use the right wheel on the joystick to refine the focus of the beam. Click Set when satisfied with the focus and uniformity.
 

 
3.  Adjust the Calibration end Slice by clicking Go to. Refine the focus using the right wheel, click Set.

 

 
4.  Repeat steps #1-3 for Path B.
 
 
 
 
 



  

  

Software Integrated Power Balancing
 

Normalizing laser power between Path A and Path B will yield the best reconstruction and analysis results. This power balancing
has a hardware component and a software component. Read below for instructions on the software component.
 
1.  Take a test capture with the desired wavelengths and imaging mode. Open the image and check the histograms

(Renormalize icon ) for each channel (wavelength and side).
 
2.  If you need to adjust the laser power per side, set the desired Laser Power and check Enable A/B power Balancing. The
set laser power will then apply to side A of each wavelength.
 

 
3.  To alter the laser power for side B of each wavelength, enter a value for Balance (B%). With B%=100 side B will have the
same laser power as A (set in the general Laser Power box).
 

NOTE:  The power of side B is considered a % of side A. When the Laser Power (for side A) is set to 25% and B should
be 12.5% enter B%=50, when A is set to 25% and B should be 50% enter B%=200. Leaving B%=100 will result in A
and B at 25% laser power.
 

 
4.  This adjustment is available for every other wavelength individually if required. Use the MLS Advanced Acquisition
Parameters dialog as shown in the following figure.
 



  

  

 
 



  

  

Data Acquisition: Piezo/ Slice Scan
1.  Have Beam and Sheet checked for both Paths.
 
2.  In the Capture group:
 

a.  Select the (first) filter for each channel A and B respectively.
b.  Lower the sheet power (5 % recommended).
c.  Check Dual Cam and Live to view your sample.
d.  Make sure the imaging FOV (camera cropping) of choice is selected.
NOTE: Click Stop again to not bleach your sample

 
3.  In the Capture Setup and Capture groups do the following:
 

a.  Select Piezo/slice scan from the drop down menu
b.  Sides – select 2 for Dual View SPIM, 1 for Single View SPIM (the second side choice will then be greyed out)
c.  First Side -  can be either A or B (only significant for Single View SPIM)
d.  Set the Number of planes and Step size (consider the camera crop)

NOTE: These values combined cannot exceed the travel of the piezo.
For example: 10X objective + 150 um Piezo
Step Size = 1µm, Number of planes =150
or
Step size = 2 µm, Number of Planes =75

e.  Set Exposure time - For USB3 connected cameras recommended exposure is 5 ms at 512 px, above 15 ms at 1k
px, above 36 ms at full chip, for interleaved mode always above 30 ms

NOTE: Check for the appropriate exposure time in LIVE mode.
 

 
4.  For timelapse acquisition choose the number of Time points and Interval at the top of the Capture group.
 
5.  Click Advanced to open the dialog to add channels.

a.  Check 2, 3, or 4, channel capture and select the filter pairs for additional channels.
b.  Check Unique Laser Power to enter an individual laser power value for each channel.
c.  Enter a laser power for side B in Balance B (%) when power balancing is enabled.
d.  Check Unique piezo /slice scan exposure (ms) to enter an individual exposure time.
e.  For colocalization assays and Single View SPIM, check Capture all channels at each piezo position at the bottom
of the advanced window.
f.  Click OK to close the Advanced Capture mode window.
 
Note: When capturing all channels at each piezo position it will disable the possibility to assign different exposure times
to different channels for capture timing reasons.

 
 



  

  

 
1.  Click Execute in the Capture group to start the capture.
 
 
 
 
 



  

  

Data Acquisition: Stage Scan
 
1.  Have Beam and Sheet checked for both Paths.
 
2.  In the Capture group:
 

a.  Select the (first) filter for each channel A and B respectively.
b.  Lower the sheet power (5 % recommended).
c.  Check Dual Cam and Live to view your sample.
d.  Make sure the imaging FOV (camera cropping) of choice is selected.
NOTE: Click Stop again to not bleach your sample

 
3.  In the Capture Setup and Capture groups do the following:
 

a.  Select Stage scan from the drop down menu
b.  Sides – select 2 for Dual View SPIM, 1 for Single View SPIM (the second side choice will then be greyed out)
c.  First Side -  can be either A or B (only significant for Single View SPIM)
d.  Set the Step size.
e.  Use the Joystick or the arrows in the XY Stage Group to move the sample in X. Set the one stage scan extents by
click Set.

 

a.  Repeat for the opposite end of the sample. The Number of planes will be calculated automatically from the set
Step size.
b.  Once the extents are set you can visit the start and end using the Go buttons, Go Center will move the stage to the
center position of the stage travel range.
 
NOTE: The calculated step size is also determined by the stage specifications and might vary slightly from the typed
value. The number of planes is calculated from travel distance the step size as follows: Travel Distance/(Step Size/
sin(45))

 

a.  Set Exposure time - For USB3 connected cameras recommended exposure is above 50 ms for full chip, 30 ms for
1k.



  

  

 
 

NOTE: Check for the appropriate exposure time in LIVE mode
 
NOTE: Once the capture parameters are set you can check the Total scan distance, Stage velocity, Scan duration, Slice
(frame) timing and number of Total images  when you click the “?” button next to the stage travel extents.
 

 
1.  For timelapse acquisition choose the number of Time points and Interval at the top of the capture group.
 
2.  Click Advanced to open the dialog to add channels.

a.  Check 2, 3, or 4, channel capture and select the filter pairs for additional channels.
b.  Check Unique Laser Power to enter an individual power value.
c.  Enter a laser power for side B in Balance B (%) when power balancing is enabled.
d.  In the drop down you have the choice of three scan modes: Interleaved (Single Pass) will capture all channels of
all sides in one run. Per-Side (Bidirectional) will capture all channels of the first side in one run and all channels of
the second side on return. Per-Side (Unidirectional) will capture all channels of the first side in one run, return the
stage and capture all channels of the second side in another run.
 
e.  Enter an appropriate value for the Overshoot delay. The required delay (in ms) is calculated as follows: Stage
Backlash in um (for default use 7 um)/ stage speed in mm/s (for info  click the “?” button next to the stage travel
extents)
 
f.  Click OK to close the Advanced Capture mode window.
 
NOTE: For stage scan captures set the calibration over a narrow range (e.g. 10 um), especially when you are working
with more opened scanner irises to create a narrower sheet.

 



  

  

 
1.  Click Execute to start the capture.
 
 
 
 
 



  

  

Data Acquisition: Combined SPIM Capture and Photomanipulation Experiments
 Before you begin this process, you must first set the appropriate MLS capture parameters as described in Data Acquisition:
Piezo/Slice Scan and  Data Acquisition: Stage Scan. Make sure the center of your SPIM image is the field of view of the finder
camera.

 
1.  For Piezo/Slice Scan the stage position for photomanipulation will be similar to the SPIM image position.
 
2.  For a stage scan, set the bounds of the scan

a.  Enable the view through the finder camera: In the Photomanipulation group of the MLS window adjust exposure
time and binning, set channel in the drop down menu, click Toggle Shutter and Live. Note: Make sure the SPIM
lasers are off or an appropriate filter is selected in the turret to avoid over exposing the finder camera with the lasers
above.

b.  Focus on the sample from below using the microscope focus or the Lower Z Stage group of the MLS window.
c.  Either click Center or move the stage along X between the stage scan bounds to the field of view of interest.
d.  Click Set to select these coordinates for the photomanipulation experiment.

 
3. Use the region tools to create an region or multiple regions in the image. These regions are where the photomanipulation will
occur.
 
4. Click Edit Sequence... to open the Photomanipulation settings.
 
6. Begin creating events by entering the Time Point, Repetitions, Duration, Laser Power and either Specific regions or All
regions to be effected by the event.
 
5. Select the desired Photomanipulation filter from the drop down menu. This filter is usually named by the schema
Vwavelength. For example, the Vector FRAP filter selection for 488 would be called V488.
 

NOTE: Always set a specific laser power - leaving it at 'Current' will not initiate the FRAP lasers during MLS capture
 
 

 
7. Click Add to save the first event.
 
8. Create additional events as desired by repeating steps 6-7. When all events are entered, click OK. This will close the Capture
Parameters dialog and take you back to the MLS controls window.
 
9. Set a timelapse by entering a value above 3 in Timepoints and set the desired Interval in the Capture group of the MLS
window. NOTE: The photomanipulation will initiate after the SPIM capture of specified timepoint.
 
10. Click Execute to begin acquisition.



  

  

During Capture
During image capture, A live monochrome window shows individual planes as they are acquired. You may open separate
windows for each channel by selecting a channel in the Status tab of Capture Controls and clicking Show or Show All to open a
window for all available channels.
 

 
For timelapse data acquisition, go to the Live tab of Capture Controls and click Show Capture Images. This will open the
Captured Images dialog that allows you to view a MIP (maximum intensity projection) image and previous timepoints before
capture completes.
 

 
 
 
 
 



  

  

MLS Post-Acquisition Processing
When using Dual View SPIM mode of MLS, the two paths will need to be fused using reconstruction algorithms. In addition to
this, any data collected using stage scan mode will need to be deskewed first to put it back into a geometrically correct location.
General information about deskewing can be found in this video about our Lattice LightSheet system. The concept is the same
but the acquisition angle is 45 degrees for Marianas LightSheet.
 
 
 
 
 
 
 

https://youtu.be/Icsj1NrIPlo


  

  

TUTORIAL: 3D-Transform Preview
This tutorial will show how to create a 3D-Transform for previewing your data or preparing them for an export as TIF file.
 
1.  Save the .sld before reviewing your captures with either the 3D Volume Viewer or the Preview tool.
 
2.  Select (highlight) the captured piezo/slice or stage scan. In the Home tab of SlideBook, select View > 3D Volume View. The
3D Volume Viewer will open a rendering of your capture in order to decide whether to process it further.
 
3.  In order to check your data and the transform you will have the selection to view your data with the following options:

•  Deskew - For Stage scan data this will be ticked by default.

•  Rotate - This rotates the second side of a Dual View SPIM capture roughly above the other side (90o rotation).

•  Coverslip Correct - This rotates the data another 45o so that the sample can be viewed like a conventional Z-Stack.
 

 

 



  

  

 
•  Registration - This applies the default transform saved in SlideBook.
NOTE: Make sure the comment does not contain the word default.

 

 



  

  

 
NOTE: The 3D Volume Viewer will only render a preview of the first timepoint of a time series capture. The 4D Volume
Viewer will render each timepoint of a timelapse one after the other.
For Single View SPIM data or should you wish to generate an image/ series that is transformed and/or de-skewed,
continue on with this tutorial. If you have a Dual View SPIM capture and wish to run combined deconvolution, continue
on with  Multiview Reconstruction in SlideBook.

 
1.  Select (highlight) the time lapse or single 3D image of the captured slice or stage scan, go to LightSheet > Multiview
Reconstruction > Channel Transforms.

 
 

 
2.  The Channel Transforms dialogue will open with the tick boxes already ticked for each capture format.

•  Rotate - This rotates the second side of a Dual View SPIM capture roughly above the other side (90o rotation) - will
be ticked for piezo/slice and stage scan types.
•  Deskew  - This will align planes to generate a geometrically correct image - will be ticked for stage scan captures
only.
•  MIP - This will create a maximum intensity projection of all 3 views (XY, XZ & YZ).
•  Z spacing same as XY - This will create isometric voxels. NOTE: this is only required if you want to use the data in
Fiji Multiview reconstruction from the created file. For e.g. only de-skewing SPIM files un-check this option to save data
storage space.

• Coverslip Correct:  - This will re-slice the data so that Z-planes appear parallel to the coverslip and not in the 45o

orientation.
•  Interpolate - This gives a high quality image.



  

  

•  You can also limit the data to:
• Intersection - This will create the preview of the volume where both volumes of each side are overlapping.
• Data Bounding Box - This will create a preview image of only the volume you assigned with the Bounding Box
tool (Multiview Reconstruction).
•  PSF Bounding Box - This will create a PSF file for the 3i joint deconvolution (Deconvolution) of Dual View
SPIM data.

• To crop channels (e.g. create a single view from dual view capture), enter the first and last channel to use and enter
the increment. NOTE: Use the channel numbers, not the names. E.g. First Channel: 1, Last Channel: 5, Increment:
2, this creates a 3 channel single view capture from a 6 channel dual view capture.
•  To crop time points enter the first and last time point to use and enter the increment. NOTE: SlideBook uses "0" for
the first timepoint. E.g. First Timepoint: 0, Last Channel: 99, Increment: 2, this creates a timelapse of 50 time
points skipping every second original time point.
•  If you have a graphic card and CUDA Toolkit installed, check GPU for a faster result.
• If you want to use the saved registration (and not only a rigid rotation), check Registration.
 
 
 

 
1.  SlideBook will create a new capture in a new .sld file with the suffix _MLS_CP. You can change this under Output File Suffix.
If the output file should appear in the same .sld file, delete the suffix. Save the slide.
 
2.  Select (highlight) the created 3D transform image. In the Home tab of SlideBook, select View > 3D Volume View or 4D
Volume View. 4D Volume Viewer will open the rendering of your capture. For Single View SPIM captures you can proceed
directly to deconvolution with either the raw or deskewed file if desired. For Dual SPIM captures, this will give you a rough idea
as to whether it is worth it to process the data using the MultiView Reconstruction (Multiview Reconstruction).
 
NOTE: some options how to process your data are listed below:
Single View SPIM data:

•  For view and export only (no quantitative analysis) - Rotate) true, Deskew) true if stage scan, Z spacing same as XY)
false, Coverslip Correct) true, Interpolate) true
•  Prepare for SlideBook CI decon or export for analysis

(1) Use raw data and raw beads for PSF (deskew a stage scans afterwards via Create Preview)
(2) Rotate) false, Deskew) true if stage scan, Z spacing same as XY) false, Coverslip Correct) false, Interpolate)
true. Apply the same for the beads file you are going to use as PSF (coverslip correct afterwards)

Dual View SPIM data:
•  For transform preview and export only (no quantitative analysis) - Rotate) true, Deskew) true if stage scan, Z spacing
same as XY) false, Coverslip Correct) true, Interpolate) true, Default Transform) true.
•  For MVR in Fiji only

(1) Piezo Slice scan: Best transfer the capture into its own .sld file, save and open in Fiji via the Multiview
Reconstruction Plugin (A=0,l B=90)
(2) Stage Scan: Rotate) false, Deskew) true if stage scan, Z spacing same as XY) true, Coverslip Correct) false,
Interpolate) true, Default Transform) false. save and open the DR file in Fiji via the Multiview Reconstruction Plugin
(A=0 B =90).

•  For MVR in Slidebook - Highlight file, select In the Home tab of SlideBook LightSheet > Multiview Reconstruction
(Multiview Reconstruction).

 
 



  

  

 
 
 
 
 
 
 



  

  

TUTORIAL: Multiview Reconstruction
 
This tutorial will walk you through aligning a Dual View SPIM image, defining a bounding box, fusing, and deconvolving the
image.
 
1.  Save the .sld before beginning.
 
2.  Select (highlight) you would like to work with. In the Home tab of SlideBook, select LightSheet > Multiview
Reconstruction > POI Detection + Registration. The3i POID + Reg dialog and the 3D Volume Viewer will open.
 

 
a.  Input:

i.   Choose the Channels for which to detect the interest points and run the automated registration in the drop
down.
ii.  Choose the Time Point for which you detected the interest points and run the automated registration using
the arrows.
iii.  Select Downsample the data to gain speed. A downsampling value of 3 would keep only every third value.
The volume size is 27 times smaller.
iv.   Limit To:

i.  Intersect: This is the data volume common to path A and Path B that has been (deskewed)
rotated.
ii.  Data Bounding Box: You can draw a Data Bounding Box in the Bounding Box 3D Volume Viewer
beforehand.

 
b.  Background:

i.  Remove Background: If the background is not 0, it should be removed, so that the Difference of Gaussian
filter does not create any artifact at the edges of the volume. These artifacts if big enough can be picked as
POI and ruin the calculation.
ii.  Ch1: The first channel background value (e.g. 488A)
iii.  Ch2: The second channel background value (e.g. 488B)
iv.  Compute Background: You can click on this button to compute the background. However it might be
slow. You can pick the background just looking at the histograms.
 

c.  Interest Point Detection:
You can let the program range through a value of sigmas and determine automatically which gives you the
smallest error.
i.  Select a Start Sigma: the first sigma to use. Must be greater or equal to 0.5. - and an End Sigma: the
final Sigma value. Should be larger than Start Sigma. Only relevant if Number of Sigmas is greater than 1.
ii.  Select a Number of Sigmas to decide for how many Sigmas in the set range the algorithm detects interest
points.
NOTE: Testing about 1-3 Sigmas from a Start Sigma: 1 to End Sigma: 4 is a good approach but can be
different for individual data. The Program will automatically select from the best combination of interest points
and registration accuracy.
 

d.  Registration:
i.  Set the Initial Max Distance (um) to a distance you want to start approaching the interest points at.



  

  

ii.  Set the Final Max Distance (um) to the distance between interest points of each side you want to
achieve.
iii.  Set the Number of Strongest Points to Use from the detected interest points.
iv.  Output DOG Filtered Images: Check this if you want to look at how the DOG filtering operated. The
larger the sigma, the larger become the "blobs".
NOTE: Testing about 1-3 Sigmas from a Start Sigma: 1 to End Sigma: 4 is a good approach but can be
different for individual data. The Program will automatically select from the best combination of interest points
and registration accuracy.
 

e.  Check the box to GPU to use CUDA accelerated processing.
f.  Click Apply to start the process. It might take a while depending on file size and how many different parameters it is
checking.
g.  The Results panel will present the interest points found, the transform and the registration accuracy (min max
distance) for each individual Sigma as well as the best transform from this range.

 
h.  The 3D Volume Viewer will update and show the 'best' transform when the check box Registration is ticked.
i.  If you are not happy with the transform select a new set of parameters and Apply again.
j.  If you want to finish the process without saving the transform, click Cancel. This will close the Registration dialogue
and not update the Default Transform.
k.  Once you are not happy with the transform click OK. This saves the registration with the capture metadata once you
save the entire .sld file.

 
1.  Next, select LightSheet > Multiview Reconstruction > Bounding Box. The default bounding box will be the intersection
of the two volumes. Once a bounding box is applied and saved with the file it will show the last defined bounding box upon
opening.

 



  

  

 
a.  Click Reset if you are not happy with the previously set bounding box.
b.  Set the width, height and depth with the sliders.
c.  Select the Bounding Box Type:

i.  Data, to deconvolve the data within the set volume.
ii.  PSF, to use the selection from beads as PSFs in the 3i Deconvolution. Select a single pair (in A and B)
of beads in the capture.

d.  Click Apply to set the bounding box and Close the dialogue.
 

NOTE: It is recommended to save the .sld file so the bounding box is saved with the capture for further processing.
 

 
2.  Finally, highlight your capture of interest and select LightSheet > Multiview Reconstruction > Deconvolution.

 



  

  

 
a.  Output:

i.  Channel Selection: Select one or several channels you want to deconvolve.
ii.  Time Points: Select/type in a single time point or tick All if you want to deconvolve all time points of a
time lapse.
iii.  Bounding Box and Registration will show you the defined values for this capture.
 

b.  Backround: Enter value or let Calculate Background to subtract the background noise before deconvolution. For
some captures this can largely improve the deconvolution result.
c.  PSF: You can use a beads file captured with the same magnification as PSF. The beads capture needs to be
registered beforehand using the 3i POI Detection + Registration and a single bead (pair) needs to be selected with
as PSF using the Bounding Box tool (tick PSF in this case).

i.  Copy a beads capture, with assigned registration and PSF bounding box into the same .sld file as the
capture to deconvolve.
ii.  Highlight the file with the PSF bounding box and hit Load from Selected Image.
iii.  You can choose a channel in Channel Selection, e.g. if you imaged beads in several colours. It is not
necessary to use a PSF from beads imaged at the same wavelength as your capture to deconvolve.
iv.  Bounding Box and Registration will show you the defined values for the PSF capture.

d.  Decon Parameters:
i.  Check the box to GPU to use CUDA accelerated processing
ii.  Set the number of Iterations. The default of 10 usually gives a good result. Increasing to 15 or 20 may
provide further improvements. For a quick preview, choose 1 or 2 iterations.
iii.  Normalize Each Channel will normalize the intensity per channel over all time points if applicable.
iv.  Tikhonov Regularization can be applied for the Sequential algorithm if wanted.
v.  Algorithm: You can decide between the Multiplicative (similar to Fiji Big Data Stitcher) or Sequential
(similar to conventional algorithm of the Fiji Multiview Reconstruction plugin).

 
e.  The required memory for this process will be shown at Memory Needed in GB.

 



  

  

 
3.  Click Apply. The deconvolution and/or fusion process can be quite intensive and may take quite a while depending on the
computer. When the process is complete, a new image will appear in a new .sld file with the suffix _MLS_DCN. You can change
this under Output File Suffix. If the output file should appear in the same .sld file, delete the suffix. Save the slide.

 
---
 
4.  Alternatively you can still use the simplified Fiji interface through Slidebook:
 
•  Select (highlight) or open the image you would like to work with. In the Home tab of SlideBook, select LightSheet >
Multiview Reconstruction > Interest Points.
 
•  SlideBook will load default Sigma and Threshold values that will define the size and number of regions to interrogate These
values are best for beads, you might want to change these depending on your samples. Small Sigma values = small size regions
to interrogate; small Threshold values = large number of regions to interrogate. Select a Channel from the dropdown menu to
interrogate.
 

NOTE: Select a channel that has bright distinct features such as puncta, dentritic spines, or nuclei. Define sigma based
on size where larger objects such as nuclei would be a value of 9 and smaller objects such as dendritic spines would be
near 1.

 

 
•  Click Preview to show the regions generated.
 

NOTE: When you click Preview, a process will be activated spawning new windows showing the algorithm activity and
log. In SlideBook, many small regions will appear in the image. When you scroll through the image, you will need to
click Preview again to update the regions generated.
 



  

  

 
•  Look to ensure that the detected interest points correspond to the "correct" features in the channel. There should not be
points where there is no structure yet too few interest points will lead to failure during registration. Adjust sigma and threshold
if necessary. If Z > XY and you want to reduce the number of interest points, check Down Sample to match the XY with the Z
resolution during interest point detection.
 

 
•  Check the box to Use GPU to use CUDA accelerated processing. Click OK to detect interest points. The log file will run through
computations. When the process is complete, the regions will disappear from the image view. The log file's last line should read
Closing .sld: slidename.

 
NOTE: SlideBook will tell you how many interest points were found for the last side. In the log file you will find
how many interest points were detected for each side Found xxxx peaks. For most data types, values for a good
registration lie between 100-5000 interest points per side.

 



  

  

 
•  Now that interest points have been defined, you can proceed with registration. Select LightSheet > Multiview
Reconstruction > Registration. The Dual View SPIM Multiview Registration dialog and the 3D Volume Viewer will open.

 
•  Choose the Channel for which you detected the interest points in the dropdown.
 

 
This is an interactive, iterative tool. Enter a Distance between given interest points in pixels and click Apply to start the
registration process. The goal is to achieve an Accuracy value (maximum error in px) equal or below 1 pixels. If the Accuracy
value decreases, continue decreasing the distance value.
 

NOTE:
•  The default distance to start with is 10 pixels with Affine or Translation transform selected, but you might want to
increase it depending on your alignment.
•  For samples with fewer interest points or larger differences between the structures from each side, start with 50
pixels or higher if necessary and/or select the Translation or even Rigid transform type for the first registration
iterations.
•  To approach the best transform (Accuracy <1 px) enter values of decreasing values. A good practice is to choose
a value slightly larger than the Accuracy in px of the last transform. e.g. Distance: 10px --> Accuracy: 5.76, next:
Distance 6 px.

 
•  You can follow the transformation with the 3D Volume Viewer. For this, have the tick box Registration checked in the capture
in the 3D Volume Viewer.
 

 



  

  

 
•  If the Accuracy value increases or you are not happy with the applied transform, click Reset and try anew with try increased
distance values and going back down in an iterative process. Use this iterative approach until you achieve an Accuracy value less
than 1 and a number of inliers >1.
•  If you are happy with the applied transform click OK. This will close the Registration dialogue and save the transform as
Default Transform in SlideBook to be used on further data if appropriate.
•  If you are not happy with the transform and do not want to save it as Default Transform, click Cancel. This will close the
Registration dialogue and not update the Default Transform
 
•  Next, proceed to LightSheet > Multiview Reconstruction > Bounding Box and  LightSheet > Multiview
Reconstruction > Fusion / Deconvolution.
 

a.  Select one of the three processing options:
Extract PSFs From Beads - Uses beads within the same sample to generate PSFs for deconvolution. This
also creates PSF transforms for Path A and Path B which can be used for future deconvolution of data.
Use Precomputed PSFs - Uses PSFs previously acquired using the same imaging system and channels. If
you select this method, you will need to identify Path A and Path B PSFs from a directory.
Fuse Only - Fuses side A with side B, does not deconvolve.
 

b.  Set the number of Iterations. The default of 10 usually gives a good result. Increasing to 15 may provide further
improvements. For a quick preview, choose 1 or 2 iterations.
 
c.  For time lapse images, check the box to Process all time points.

 

 
•  Click OK. The deconvolution and/or fusion process can be quite intensive and may take quite a while depending on the 
computer. When the process is complete, a new image will appear on the .sld. Save the .sld before proceeding with analysis or
rendering
 
 



  

  

MLS Troubleshooting
 
Below, you will find a list of troubleshooting tips. For additional assistance, please contact 3i Support.
 
•  If you are having trouble aligning the beams, turn everything off and reset the filter cubes and mirror cubes to zero (middle
position of screws), turn the objective bushings in (clockwise) and start the alignment procedure from scratch.
 
•  Will not always see a display during acquisition or live update too slow: This depends on the selected frame rate.
 
•  Beams/ Sheet appear out of focus:

a.  Check with Neutral All and then Adjust after hitting Go for each path. If no change, repeat calibration.
b.  Re-align and re-calibrate when buffers are switched.

 
•  Move joy stick off of air table during operation.
•  The 3D Volume Viewer does not rotate data correctly:

a.  Make sure the comment of the captures contain either piezo/ slice or stage scan. To do so, select the image in
the .sld and press Ctrl + I then review the Comments field.
b.  Make sure the A is the first captured side. If it is B go to Analyze -> Reformate -> Rotate -> Flip Horizontal

 
 

mailto:support@intelligent-imaging.com
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